COMPUTADORAS
Entrenamiento Basico
Windows xp & Microsoft Word Training

Esquema Introductivo (Las Computadoras)

Una computadora es un dispositivo electronico que ejecuta las instrucciones contenida en
un programa. Una computadora tiene cuatro funciones principales:

Acepta informacion=»  Acepta informacion = Input
Procesa datos =»  Procesamiento = Processing
Produce una salida = Salida = Output

Almacena resultados=» Almacenamiento Storage

| TIPOS DE COMPUTADORAS:

Para entender mejor este concepto podemos dividir las computadoras en dos
grandes grupos segun su funcion:

A) Anéloga: Organiza informacion en medidas de propiedades fisica.

B) Digital:  Las computadoras digitales son de alta velocidad y se
programan para hacer calculaciones matematicas,
comparaciones de valores, almacenar informacion.
Organizan informacion reconociendo la presencia o
ausencia de electricidad: 1 (on) 0 (off).

I DEFINICION:
Como las computadoras son unas maquinas y usan programas para funcionar
podemos dividirlas en dos partes generales: Hardware y Software:

— A Hardware (Equipo, la computadora, parte fisica)
\D}@ 1) Equipo de almacenamiento (Input devices)
-Disco duro (Hard disk)
-CD ROM
s -DVD )
— 4 -Disco flexible (Floppy diskette)
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2) Equipos de ingreso (Input devices) /,_,./.
-Teclado (Keyboard) . T 4
-Raton (Mouse) ﬂ “ / o~
B) Software (Programas)
-Microsoft Office Word
-Microsoft Office Excel
-WordPerfect Office 2000
C) Memoria (Memory)

1- ROM (Read Only Memory)
BIOS (Basic Input Operating System)

2- RAM (Random Access Memory)

C) User (Usuario)

D) Interface
1 - DOS (Disk Operating System
2 - Utilities (Utilidades)
3 - Applications (Programas)
- Word processing (Procesador de palabras)

- Database

- Spreadsheet

- Programming Language

- Graphics

- Recreational (recreacion)

- Otros

Ingreso (Input)

E) EI Concepto de: Proceso (Process)

Egreso (Output)

i TAMARNO DE LAS COMPUTADORAS:

Las computadoras son facturadas o disefiadas en diferentes tamafios, segun el proposito para el
que se adquieren, el pronostico del tiempo y el sistema de seguridad social de Estados Unidos
demandan de grandes artefactos (dispositivos):

A) Sistemas Grandes
1 - Super computadoras
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2 - Computadoras mainframe
3 - Mini computadoras

B) Sistemas Pequefios
1 - PC - personal computer(s)
2 - Laptop
3 - Handheld

v UTILIZACION BASICA:

A) Procesamiento de datos
B) Control
C) Disefio y desarrollo

1 - Productos

2 - ldeas

\Y; FLUTACION (FLOW) DE LA INFORMACION (DATA):

Aungue la las computadoras pueden asistir para hacer la informacién mas precisa y ldgica,
ellas producen lo gue se le proporciona porque la informacion entra, se procesa y sale, si los
nameros son errdneos es probable que el resultado también sea erréneo, debemos se
cuidadosos.
A) Input (Entrada)

1 - Keyboard (Teclado)

2 - Mouse (Rat6n)

3 - Scanner (Escaner, explorador)

B) Processing (Procesamiento)
1 - El procesador

C) Output (Salida)
1 - Monitor
2 - Impresora (Printer)

El Mouse (Raton)

Este pequefio dispositivo fue inventado hace algun tiempo y tomo6 maés auge con el uso de los
programas mucho mas gréaficos. Su nombre proviene por el modo como el cursor se mueve en la
pantalla, como un ratén que va a todos lados, los botones mas usados son el izquierdo [de accion,
(ejecuta)] y el derecho [opcidn (ofrece alternativas)

Mouse
Como se usa el Raton ///< ;\ -
(the Mouse) / , \dBOtonh
\ -‘(-, ‘. erecno



Para correr o abrir un programa, documento o archivo se hace un clic doble (double click).
hacer un clic con el boton derecho en el Desktop ejecutara el Quick men (menu rapido)

[ % mml - ¥
I Folder

=  Shorkcuk

a Briefcase

S Bitrnap Images
M Documento de Microsoft word
Aplicacion Microsoft OFfice Access

@j Presentacian de Microsoft PowerPoink
ﬁ Adobe Phokoshop Elements Image

l—@] Cocurmento de Microsoft CFfice Publisher
;D uatkro Pro 9 Mokteboolk

Eﬂ Corel Presentations 9 Show

Text Documenkt

Eﬂ Wawve Sound

'@ ‘wardPerfeck 3 Docurnent

orel Presentations 9 Drawing

El_j Hoja de calculo de Microsoft Excel

3 Compressed {(zipped) Folder

arrange Icons By
Refresh

Undo Renamne Crrl+Z

LISE DataBank

Toolbars i

Show Open Windows
Task Manager

v Lock the Taskbar
Properties

Arrange Icons By Mame
Refresh Size
Tvpe

Paste Modified

Paste Shortcut
Undo Rename Chrl4+-Z

Auko Arrange
D) Align ko Grid

Properties

Show Deskiop Icons iTunes

Lock web Items on Deskiop rﬁ
Run Deskkop Cleanup Wizard i




El sistema Windows Xp

Cuando su computadora haya terminado de cargar el sistema
Windows lo primero que observara es un area que cubre toda la
pantalla que se llama el Escritorio (Desktop), el nombre esta
inspirado en las funciones que uno hace cuando usa un escritorio.

/ Windows Desktop
/ "f 3 (Escritorio)

Te bagin click your reer name

LPara apagar

Usar Windows xp es bien facil, en la parte de abajo hay una banda Ilamada Taskbar, en el
extremo derecho de esta banda aparece Start. Haga clic en Start

Inmediatamente proceda hacer Clic en All Programs

“Eha, Search
L Rermoke Assistance

==
3 FMSM Messenger 7.5

All Programs D

@l Log OFF rﬁ:l | Turn OFF Computer

# MSM Messen... 5 2 Microsaf,



Moving Windows around / Moviendo las ventanas alrededor
Todo lo que usted hara en su computadora aparecera en unas ventanas (Windows) y se puede
abrir tantas ventanas como sean necesarias. Usted puede moverlas, extenderlas, disminuirlas, o
colocarlas de diferente orden.

Botones de
control

= Local Disk (C:)
© File Edit View Favorites Tools Help

egack - \_/| lﬁ /:\J Search || Folders '

: Address |n=.p i

B[(=I[ES
| :!r

|2

Botdn
Para Cerrar

e B B

Acedac Benjamin Boda EBri'2000

W

File and Folder Tasks | #

77 Make anew folder

(%) tP#:I&I; ;his folder to D D D

kf Share this folder Caminera Class 600 Computer Cla Config. Msi

Other Places D D D

\B\otén para
Minimizar

g My Computer Conkral Controlde mi Documents Download
5y My Documents ser and Settings

|5y Shared Documents N D D D
g Iy Mebwork Places

EPSOMNREG

G

w | Dowrloaded  Duartianos

FIESSENQER /0

All Programs (Todos los programas)

Al colocar el cursor del Mouse sobre All Programs aparecera una lista de los programas
instalados en su computadora.

-i Microsoft OFfice Wor
g Logitech CuickZam

eﬁi FMicrosoft OFfice Accd
Z00z

Microsoft OFfice Publ
2003

»
Lg Femote Assiskance
| ===ty

a MMSK Messenger 7.5

| UK Label_| I
Hermera Photo-Objecks Gallery For HP o Shel-reator

HF PrecisionScan
iPhoto Flus <+

@ weindowes Media Player

3 Windows Messenger

iTunes
Logitech
McAFes
Mediaking Talk
Microsoft OFfice
Microsoft Press
Mero

Cptimum Snline

CaickTime
Startup
TDE LabelCreator

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥

USE DataBank

icono (Icon)



Las pequefias gréaficas en la pantalla se llaman Icons (Iconos), son como pequefias puertas para

entrar a los documentos y programas almacenados en su computadora. Coloque el cursor del

Mouse sobre el Icon, haga clic dos veces para abrir el programa o documento (File).

Iconos

Taskbar iBarra de tareasi

Cada vez que usted abre una ventana (window), un boton que lo representa aparece en el
Taskbar, este boton desaparece cuando usted cierra la ventana.

Esta barra también contiene el Start mend, y un area de notificacion donde hay un reloj, también
en esta area se puede ver notificaciones de actividades que toman lugar durante las operaciones,
como por ejemplo cuando estan disponibles renovaciones (update) de su version de Windows.

Algunos Iconos Importantes en el Desktop

My Computer

My Computer

Internet Explorer

Recycle Bin

del Desktop pueden ser puestos coprandolos del Startbar. Usando el bo

My Computer (Mi Computadora) es
muy Util para administrar las
carpetas, los documentos y otros.
Internet Explorer es para explorar el
Internet si su computadora esta
conectada a un proveedor de servicio
de Internet.

Al Recycle Bin vienen los
documentos y otros que son barrados,
de ahi podrian ser recuperados.




derecho del Mouse sobre el programa en la lista se escoge Copy, y después en el Desktop
usando el botén derecho del Mouse selecciones Paste. Tambien se puede escoger Send (Enviar)

El Menu Rapido (Quick Menu)

Quick Menu ejecutado en Word

Es muy util y puede siempre lograrse & Cortar
en muchos programas incluyendo el 53 Copiar
Desktop haciendo un Clic con el boton (4 Pegar
derecho del Mouse (Ratén). Las A Fuente..
selecciones mas usados son Copy, =% parrafo...
Paste, Yy New. EIl QUiCk Menu. = Mumeracion y virfietas..,
Cambia segun el lugar donde se | Hipervinculo...
ejecuta, el Comando New aparece en el &l suscar...
Desktop y My computer. Sindnimos .
ﬂ?ﬁ Traducir
Seleccionar texko con Farmato similar

My Computer (paramanejar archivos y folderes)

By conpuer

© File Edit View Favorites Tools  Help

\_#:. e - Lw )__j Search i Folders '

| Address | " My Computer v| =3
A
System Tasks 1
Wigw system information (’%
; Add or remove programs = =
[@ Change a setting
314 Floppy (6:) DYD Drive (D:) CD-RM Drive (E:)

Other Places

ﬁg My Mebwork Places I_._,_--. —~
B My Documents @ (":)
|5 Shared Documents

[ Contral Panel

Removable Disk (F:) Logitech QuickiZam Shared Documents
Communicate STX #2

»

Details



Files and Folders

Windows hace facil almacenar documentos y fdlder en diferentes localidades, textos, imagenes,
musica. Viene con algunos folderes (carpetas) ya instalados como son: My Documents, My
Picture (fotos, iméagenes) y My Music. Esos félderes son faciles de localizar en la parte
izquierda del Start Menu, estan convenientemente conectados con otras tareas que usted ejecuta
mas recientemente.

Como Crear un Folder D
Se pueden crear un félder en el Desktop presionando el boton derecho del Mouse y seleccionar:

*

Arrange Icons By
Refresh

= New
=> Folder
... Nombrar el folder

= Zhorkcuk

a Briefrase
ﬂ Eitmap Inmage
@’] Documento de Microsoft Word

FProperties

Crear, Mover, renombrar, Abrir y Borrar Folders Usando Muy Computer:

= Abra My Computer en el Desktop (doble clic —-Mouse botdn izquierdo)
=» Selecciones el Disco: Local Disk (C:)

=» Clic en File (También puedes hacer un clic - boton derecho)

= New D

=> Fdlder

=>» Nombre el Folder

Nota: Con un clic doble -boton izquierdo-se puede abrir los Folderes

mlocatvikicy . [Crywese [LE

. File Edit View Favorites Tools Help

@Back M~ lﬁ /.._\JSearch = Folders v

| Address |~=¢° [} Vl
Mane Size  Twpe Date Maodified

System Tasks | I Acedac Filz Folder 2/5{2006 10:15 PM

L5 Benjamin File Folder 3I10/2005 11:34 PM

File and Folder Tasks Eoda File Faolder SI2312005 7:33 PM
Eri'2000 File Folder 143002005 3:30 PM

£F Make a new Folder IS Caminero Wiew » File Folder 12/12/2005 10:39 PM
&3 Publish this Folder to the T Class 600 . File Folder 11/24/2005 4145 PM
\Web Arrange Icons By y
I Computer Cla Refresh File Folder 102212005 7:50 AM
onfig. Msi ile: Folder B
[ Share this Folder 15 Config. Msi File Fold 10/30/2005 7:24 AM
Control aste File Folder 12/25/200% 5:55 PM
] | Past le Fold 125
Contraol de mi ser aste Shorbcul File Folder 11/4f2005 10:21 PM
=~ ] I d Paste Shartcut le Fold f4y:
&
Other Places (C)Documents and settiy | N File Folder 1/15{2005 9:20 PM
.’_'J My Computer |5 Download File Folder 12202005 1:19 PM
D Py BRI E]Down!oaded all Properties F!Ie Folder 10/3f2005 6:25 AM
IC)Duartianos File Folder 1IZ51Z005 12:42 PM
[ Shared Documents [P EDSAMD RS Fila Enldar 1204 MINNE FANE AR



Cambiando el listado
La manera de ver el listado se puede cambiar usando el comando View en el Menl

Fmu tdivs o~ -0 - L EW e,

== Local Disk (C:)

Fil=  Edit m Fawvarites  Tools  Help .#

E Toolbars 3
£ @ Back Skabus Bar Search F'FT Folders v
= Explorer Bar 3 .
: address | v| E®
Thumbnails
| b S | Teme ~
Tiles =
IChacedac File Folder
Icons =
Lisk Ch Benjamin File Folder b
File and F| g patails [ChBoda File Folder L
IC)Briz000 File Folder

Control Panel (Panel de Control)

Cambie la configuracion de la computadora, pero debe con cuidado y de ser necesario, de lo
contrario no lo haga, usando el Control Panel:

=>» Clic on 4 Start § Control Panel
9 COﬂtrOl Pan6| ¢ Fle Edb View Favortes Took  Help
S ) S
Clésica a la de e [ colrnd
Categoria. ﬁ” || ~ |
RNT i Control P 3] -1
From Classic View to a1  Pick a category
— ?@ Appearance and Themes ﬁ Printers and Other Hardware
See Also ‘\_- L
R Windows Lpdate i) s
I Help and Suppart Ygl Network and Internet Connections .y, User Accounts
Para cambiar Q) Helpend Supp e v
para |a Vi sta o gltjr;ieurngontro\ Panel

Clasica, en la
gue se ven mas
dispositivos

. & - _
Add or Remove Programs i ! Datg, Time, Language, and Regional
' Options

v, . . - .
- ‘}) Sounds, Speech, and Audio Devices 7 Accessibility Options

' Performance and Maintenance
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Las propiedades del Desktop pueden ser cambiadas haciendo un Clic con el botdn derecho del
Mouse y seleccionar Properties (Propiedades) De esta manera se pueden Cambiar:

Fme Mliws om0

Display Properties

9 Themes Themes | Desktop || Screen Saver || Appearance | Settings |

9 Desktop B theme iz a background plus a zet of zounds, iconz, and other elements
to help you perzonalize pour computer with one click.
=>» Screen Saber

=> Appearance
=>» Settings

Theme:

P [M odified] Delete

Active Window N =1E3

indowy T et

[ (0] 4 ] [ Cancel ] Apply

Nota:

Es recomendable tener cuidado cuando se entra a Settings, al cambiar la configuracién se puede
afectar el funcionamiento de algunos dispositivos (Ejemplo: graphic card).
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Introduccion Microsoft Office

Microsoft Office es un paquete de programas que incluye principalmente
Procesador de Palabras (Microsoft Office Word)
Planillas de Calcul6 (Microsoft Office Excel)
Bases de Datos (Microsoft Office Access)
Presentations (Microsoft Office PowerPoint)

e Otros
Estos programas ofrecen los elementos necesarios para crear, editar y manejar y almacenar
documentos de diferentes tipos tanto personales como de negocios. Estos programas se han
venido desarrollando para satisfacer las necesidades y exigencias de una persona con necesidades
bésicas, 0 para un usuario avanzado. Durante este entrenamiento practico usted determinara su
tiempo y dedicacidn, de ello dependera el aprovechamiento y el nivel al que se desea llegar para
el desarrollo de habilidades y destrezas en materia de computadoras.
Al terminar este curso practico usted dominara los elementos indispensables para crear los
documentos mas comunes pero Utiles tanto para la administracion del hogar como para los
negocios.

TRABAJANDO CON MICROSOFT OFFICE WORD

I} Documento3d - Microsoft Word

* Archivo  Edicion  Yer Insertar Formato  Herramienta: Tabla  Wentana Escriba una pregunta

AENENE NEPENE PN kA SIENEET:- WA RS 1 Yo g - =[] &1 91 100 --.g..|44Lectura'
P A4 Mormal - Tlmé\sNewRoman - 12 = | N X\S |.§ == .%-l i= = iF iF | [F] - W év!
[t] E'l\'2'3\'\4'\5'ﬂ'? B
: Menu . |
| Title Bar y
I-beam (Punto Tools bar
. para Insertar
: texto) Ruler
¥ Scroll Bars
' kd
e re - +
Area de trabajo 5
) E
LICELRY | 3]
iDbujar~ L | Autoformas e N w [ O A ] 2 g @] [l S - & A= T lj. " | H
Pag. 1 Sec, 1 11 a1 Lin, 1 Col, 1 Espariol (Re
W nikivizew (5 | dokafrvmeews S S T 1o b=l @l o (@l (&l | Ma - # o A = —— = |k .
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Status Bar (barra informativa) que muestra el numero de pagina
donde esta el punto de insertar texto, muestra cuantas paginas tiene el
documento, y el numero de columnas donde est4 el punto de insertar
texto.

I‘ Page 1 Sec 1 11 at 1" In1 <ol spanish (Do [CEf

T IUC T TE TF [ (I T0 1T HEYCT THT 10 T10; NI OCS I F € ORIy [P L BTy TCTe T | 1]

Formato del texto (Text Format)

Gl Document1 - Microsoft Word =10l =]
i - FEle Edit Wew Insert Format  Tools  Table  window  Help Type a question for help =
NEESY|(ERY | IBRS | v- - @BEORE T we @ 2
LA Mormal ~ TimesMewRoman - 12 ~ B 7 U E IS EE (LA »
|
Format Fuente Tamarfio del texto Bo|q _Align
(Formato) (Font) (Negrita) (Alineamiento)

Toolbar (Barra de Herramientas)

Para tener acceso al Toolbar hay que hacer Clic en View (Ver) y escogar Toolbar, entonces aparecen los
indicadores para cambiar toda una serie de comandos que permiten cambiar el Menu escogiendo si se prefiere
ver algunas otras barras. Los mas comunes y necesarios son Standard (Estandar) y Format (Formato)
= Vew (Ver)
= Toosbarr (Barras de Herramientas)
=> Seleccionar

iZl Document3 - Microsoft Word H |EI =

- File Edit Insert Format  Tools  Table  Window  Help Type a guestion for help
BRI o-c- @BORES BT o -0,
ebllayout 2-BruEE=ssiE-EEEE0-2-A-.
Print Layout
Cutline
Task Pane
| Toolbars 3 |E| Standard
Ruler Formatting
| m Document Map AutoText
D Header and Footer Control Toolbox
Database
Markup Drawing
[E Fulscreen Farms
Zoom... Frames
Mail Merge
Cutlining
Picture
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Zh Documentod, - Microsoft Word
:| archivo | Edicién  Wer Insertar Formato  Herrar

1 Huewva...

=]

[l

Gk L

1 Como Crear un documento Nuevo:
>File
=>New
(O haga click en el icono)
I
Para Almacenar su documento use:
>File
=>Save
Si se quiere nombrar o cambiar el nombre,
o0 hacer una copia de su documento usar Save As
>File
SSave as... (Abrir el folder
y escribir el nombre)
2 Como Abrir un documento gque ya existe:

> File
=>Open (O haga click in el icono)

Abrir el Félder y seleccionar el documento.

Abrir...

Cerrar

CtrH-a

Guardar

Guardar coma. .

Guardar como pagina Web. .

Buscar archivo...

il Document? - Microsoft Word

@;Dj

ile:

dit  Wiew  Insert

Farmat

CtrHa

Tools  Tahle

Chrl+M
Chrl0

Chrl4+3

Save As..,

g8

Save as Web Page...

Search. ..

0§ Documento2 - Microsoft Word

il Archivo | Edicidn  ¥er Inserkar Formato  Herramien!

r

A. COMO EDITAR (CAMBIAR) TEXTO:
a. Haga Clic con el boton izquierdo de Mouse y manténgalo presionado
mientras arrastra el Mouse hasta el final del area de texto que quieres

cambiar. Después que el texto ha sido seleccionado usted puedes usar

el menu para hacer cambios.

Guardar como. ..

] Hueva,..

EEES Ctri+a
Cerrar

|l Guardar Ciri+G

Ejemplo: La CASAIdEINUISESIGRaRGENABORItA como ninguna.

b. Otra manera para seleccionar el texto: Usted puedes hacer clic al
comienzo del area que quieres cambiar, luego mantenga presionado la
tecla Shift y haga Clic otra vez al final del texto que quieres cambiar.

Un ejemplo:

Hace wva mucho tiempo due en medlo del mar Caribe se descubrieron unas islas muy

apoyada por una potencia de Europa en neces1dad de conguistar territorios para expandir

su 1mp Erio.
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Como cambiar los margenes de su documento:

= File
=>» Page Setup

Entre margen(es) preferido en medida de pulgadas

Como cambiar el tamario y/o tipo de papel:

=>File
=>Page Setup

Seleccione el tamafio de la pagina o papel a

imprimir

Ejemplo: (Letter 81/2 X 11, Legal 81/2 x 14))

Como cambiar la
orientacion del papel a imprimer:
=>File

=>Page Setup =» Portrait =» Landscape

Como Insertar una pagina nueva en su documento:

Configurar pagina @E‘
Wargenes | pagel | Dis |
Mirgenes
Superior: E| Irferiors 1" =
Tzquierdo: 1.25" E]: Derecho:  |1.25" =

Epuedemation: [ =] Posicén del mergen rtemne:  [zqurda ~

Vaies pignag:

Viska previa
Aplcar &

Si usted continua escribiendo automaticamente se producird una nueva pagina,

pero se quieres insertar una pagina manualmente:

=> Insert
=>»Break...

Como insertar la
fecha actual en su documento:

=>»Insert =»Date and Time...
Selecciones el formato de fecha des
(March 2, 2006)

Como numerar las
paginas de su documento:
=> Insert
=>Page Number...

Fecha y hora

Faormatos disponibles:

Lunes, 20 de Febrero de 2006
20 de Febrero de 2006
20/02/06

2006-02-20

20-Feb-06

20.02. 2008

20 Feb. 06

20.02.06

Febrero de 2006

Feb-06

20/02)2006 02:46 p.m.
20/02/2006 02:46:19 p.m,
02:46:19 p.m,

2:46:19 p.rn.

14:46

14:46:19

Predeterminar...

Idioma:
|Espaﬁ0| (Republica Dorinicana) ﬂ

J ™ Actualizar autornaticamente

Acepkar |

Cancelar

Escoja la posicién deseada (I1zquerda, Derecha, Centro)

Como insertar graficas

(fotos, figures) en su documento:

=> |nsert

=>»Picture

Abra el Félder y seleccione el objeto

15

rosoft Word

=

Insertar | Formato  Herramientas Tabla  Wentana

Sirmbola...

B9 G

Imagen ] |

Imagenes predisefiadas...

| 20 7

b
% Desde archivo, .,

T OT=ET o TP O

I T

Desde escaner o camara...
oo

Mueva dibujo

Aukoformas

e B & Wk B

Wwordart, .,




Para ver su documento en una ventana normal:

=>View =>»Normal
Como cambiar el menu de MS-Word:
9VI€W Fle Edt | View | Insert  Fomat  Jook  Table Window Help
=>Toolbar.. 0 EE tm B o-@an o
(Seleccione) [ | YebLovod S
. A EI Standard
Para hace visible la regla con g '] ot

) Ducument Map AukaTest

las medidas en pulgadas Clic on:

D Header and Faoter Control Tookox

Zoom,

9 Vl ew Database
> Ruler : ¥ e

Las tabulaciones (Tabs) pueden ser, Izquierda, Central, Derecha, Decimal, etc.
Haga Clic en esa L al extremo izquierdo de la regla.

il Document? - Microsoft Word

Wiew Insert  Format  Tools  Table  Wwindow  Help x
an &Y B v - &0 % -2 TmeskewRoman - 12 - B I U % = =2
|I."'E'"I"'1"'I"'2"'I"'3"'I"'4'"I"'S"'I---a---l"'?' Z
En esta regla se puede tabular el J— =
- dbulaciones
documento usando los espacios —
. Posicion: Tabulaciones predeterminadas:
deseados: Ee e =
., ﬁ'g“ J Tabulariones que desea borrar:
También se puede tabular 55
el documento usando el Menu: =]
eFormat Alineacidn
(" Izquierda " Centrada " Derecha
eTabS .. f* Decimnal ™ Barra
Escriba las tabulaciones necesarias. el
Observe los botones opcionales en la & ihngue 2. C g
a4

parte inferior de la ventana.

Eijar | Eliminar | Eliminar todas |

Aceptar | Cancelar |
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Necesarias

Para disefiar una tabla manualmente, como usando un lapiz:

=>Table
=>Draw

= Table \ Unabarra de herramienta aparece con varios instrumentos que se pueden usar.

4 Documento? - Microsoft Word

I archivo  Edicidn Mer  Inserkar

RN =N~ WEWE NI BN 2 W e

Tabla | Wentana
I:Lﬁ Dibujar tabla

Formakto Herramienktas T

i A4 mormal

- Times Mew Foman

- 12 "| N Insertar

P S T

Eliminar

T
Seleccionar

17

15  Paraver su documento COMO  pymmwmwmes
16 serd impreso (print): YT
S File ol IO I TS T SO
=> Print Preview —
Selecciones porcentaje de ah
Visibilidad, o paginas multiples.
. 4 Documento’ - Microsoft Word ) &
17 Como S€ dlsena una i frchivo  Edicisn  Wer Insertar Formato  Herramientas | Tabla | Ventana 7
tabla en Word.: NEHESERS g B fﬁlDibujartabla =lg gl T
4_4 Marmal ~ Times NewRoman » 12« | N Insertar 4 ‘ ) 1abla...
>Table HA S o) ) ) F e conpode oz 2 ] | BT " il Cohesalaz
=> |nsert L] g EEEEESEEERRERE ERE : Selcdonar | A Colnas ala d
9Tab|e I I I I ﬂ Autoformato d tablas... 23 Fias en la parte
Escoga las columnas y filas [ octar eas dedvisitn |4 Fiesen e parte
- Propiedades de tabla, .. 39 Celdas...
y



Trabajar con tablas requiere de habilidad que s6lo puede ser obtenida con la practica. En muchos casos
puede resultar mas apropiado usar un programa como Microsoft Office Excel.

Idondaz Tuesday || Wednesday | Thursday Fridaw Saturday

18 Como se organiza en orden alfabetico una lista en su documento:

=>Table

=>Sort..

Selecciones: ° Ascending
° Dscending

Escoja: -Paragraph (Parrafos)
-Field (Campo)
-Text (Texto)

- Ordenar por
Antonio Durango = Tpo: [retn =] © Gscendente

'arrafos|

Bill Clinton " Descendente
Carlos Escobar
Julio Jaramillo Lulw—_l ] °
Norman McCullough «
Ramén Reyes
Luego por
p
=l ~
La lista serd
- (=
Jpciones. .. Aceptar I Cancelar
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Options
Security I Spelling & Grammar
User Information Cormpatibility
Wigw General ] Edit ]

V' Smart tags

IV animated bext

IV Horizontal scrall bar
IV “ertical scroll bar
[ Picture placeholders

¥ Highlight

[ Bookmarks
[v sStatus bar
v ScreenTips

Formatting marks
[™ Tab characters ™ Hidden text
[ Spaces [ Optional hyphens
[ Paragraph marks [ all

Print and Web Lavout options
[w Drawings
[ obiject anchors
[ Text boundaries

Outline and Mormal options
[ Wrap to window

Style area width: 0"

@

Track Changes
File Lacations

Prink l Save

IV Windows in Taskbar

[~ Field codes
Field shading:

when selected -

IV White space between pages (Print view only)
IV “ertical ruler (Print view only)

-
-

[ Draft font:

| I

CK | Cancel
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Opciones (Options)

Muchas opciones pueden ser
cambiadas en Ms. Word
usando:
=> Tools

= Options

Se puede cambiar la coloca
predeterminada de los
documentos (Ejemplo: My
documents). Solamente
cambie aquellas opciones
cuyos efectos usted conoce.




MICROSOFT OFFICE EXCEL, (LO BASICO)

3 Microsoft Excel - Book1

Data  ‘window Help

File Edit \Wiew Insert Format Tools
hEEa & ® @@L%J,\Q?N
A1 - e

A | B D F
1 |
g Menu
: Title Bar
8 ColurJnn C Toolsbar
a8
9
10
11
12
13 Row 13
14
15
16
17
T Statiis Rar
19 —
20
FRrEre " Sheetl  Sheet2 # Sheet3 / [ <]

Ready

| USANDO EXCEL:

1. Como comenzar (correr) Excel

==> Start

==>Programs

==>Excel
También se puede comenzar haciendo doble Clic sobre el icono (Excel) en el
Desktop.

Como salir de Excel (Exit)
==>File
==>EXxit
También se puede hacer Click en la X en la parte arriba a la derecha (esquina);
O bien se puede usar la combinacién Alt_F4.
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I QUE ES EL WORKBOOK:

El Workbook es una coleccion de paginas (documentos, sheets, archivos) llamado
Worksheets. El Workbook puede contener hasta 16 Worksheets, depende de la cantidad

de memoria disponible.

I QUE ES EL WORKSHEET:

Cada worksheet esta compuesto de un conjunto de celdas tabuladas. Las lineas van desde
la numero 1 hasta la numero 16, 384 en el margen de la derecha. Las columnas arriba se
extienden desde la numero 1 hasta la numero 256. Esto significa que un worksheet
contiene 4 millones de celdas (textos, formulas, nimeros).

E3 Microsoft Excel - Reporte regional

Eile Edik Wi Inserk Formak Tools Daka v imd o Help

D= S &% (B o @ = -2 E T o ECEE
=18 - k23
A =] [ ] E F =] H

SANTANA ASSOCIATE. INC.

2020 Broadway Avenue
MMewe York, MY 10007
(21 2) Fa5-8871

Reporte 20065

1
2
3
El
5
=}
i
=1 MNAME EAST WEST NORTH SOUTH TOTAL
=] E. SGonzalez prinn] Sa0 A00 1500 2400
10 T. Thomas 225 =250 373 1800 2648
11 H. Maldonado 150 333 100 =]u]n] 1483
12 k. Burgos S0 A5 j=]u] S00 B55
13 J. Ramirez =210 400 |=]u]n] 1200 2410
14 TOTAL 515 1328 15535 S900 95965
15
16 SALES REPORT 2006
17
2000 1
15 | Py I EEAST ——a
19 I
1000 mEST
20 L i
=1 SO0 I:.- O MNORTH
@ OS0oUTH
22 1 2 e 4 =
23
. |
4 4 » M Sheetl  Sheetz f Sheetz [«
Column D Y| EZ Microsoft Excel - Book2 Filas 5- 6
(COIumnaS) i Edit Miew Insert Format  Tools Data  Window  Help (ROW)

200~ @M = )k =
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1 CELDA:

La celda es el punto donde coinciden un numero (Linea) una letra (Columna).
Esta se constituye en una direccion en la memoria a la que nos podemos referir
como elemento basico para calcular, presentar textos o graficos de diferentes
formatos. Por ejemplo A2 se refiere a columna 1 linea 2.

3 E Microsoft Excel - Book1

i File Edit Wiew Insert Format Tools Data ¥
~ 0= E &8 & B % = -2 0!

\ B2 - B
B C 0 E

A
il

CeldaB2-C4

I~

2 CELDA ACTIVA:

Cuando selecciona una celda usando el
Mouse 0 moviéndose a ésta usando el
teclado, esta se convierte en una célula
activa. La Cajilla de Nombre (Name Box) arriba muestra la referencia de la
celula activa (Active Cell, ejemplo B4).

ST e L kD —

CREAR UN NUEVO WORKBOOK

| E3 Microsoft Excel - Book2

@ File Edit Mew Insert Format  Tools  Date

< File NEEHS &% B v- @5 -4

< New B2 - £

A B c n]
1}

2 PARA ABRIR UN WORKBOOK

= W kd —

< File
< Open
Seleccione directorio, File type, file name Celda Activa

(cursor)

3 SAVE YOUR WORK (Salvar su trabajo)

File

Save

File

Save As...

AN N AN A

4 CERRAR EL WORKBOOK (Close)

< File
< Close

5 CERRAR TODOS LOS WORKBOOKS A LA VEZ
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< File
< Close All

6 PRINTING A WORKSHEET (IMPRIMIR SU TRABAJO)

< File
< Print
< Clic OK

7 ENTRANDO INFORMACION EN LA CELULA (CELL).
1. Seleccione la celda haciendo clic con el Mouse.

2. Escriba el texto o nimero.
3. Presiones Entre o selecciones una celda diferente usando el Mouse.

8 CARACTERES COMUNES EN LOS NUMEROS

) 0 hasta 9 Cualquier combinacion numerica

) + Indica exponente cuando aparece junto a la E
- Indica numero negativo

) O Indica numero negativo

) , Marca de miles

) / Indica fracciones o separa la fecha

) $ Indica Signo de ddlar

) % Indica por ciento

) Indica decimal

) Indica Exponente

) e Indica Exponente

) : Separa Tiempo (12:00 p.m.)

9 MAS DE UNA CELDA PUEDE SELECCIONARSE

a) Mas de una célula se puede seleccionar. EI modo mas facil es usando el
Mouse presionando el botdn de la izquierda y deslizarlo cubriendo varias
células y después liberarlo el boton.

b)

Ejemplo
63 8 @ File Edit Wiew Insert Formatb Tools  Data  Winc
.84
OE > prial -0 - B I U
63.84 B2 - e 76.98
63.84 L -
2 76.95 BB.65
63.84 FANET 8812
3409 43.82
]
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638.4
C) Tipos de Datos (informacion)

# Text

# Numbers

# Logical Values (TRUE AND FALSO) Verdad o Falso.
# Errors (Si una formula trata de dividir por cero)

10 MOVIENDO Y COPIANDO CELDAS:

1 Selecciones las celdas a moverse o copiarse
Haga Click con el botén derecho del mouse y escoja Copy
y luego Paste en nuevo lugar.

2 a) Para mover apunte al borde exterior de las celdas selectas.
La figura del Mouse se convierte en una flecha.

b) Haga Click y arrastre las células hacia el nuevo lugar.

HACIENDO CALCULACIONES CON FORMULAS:

Una formula es esencialmente una secuencia de valores y operadores que comienza con
un signo de igual (=) y produce un nuevo resultado. Excel comprende varios cientos de
formulas ya pre-establecidas que se llaman funciones, que han sido disefiada para
ejecutar diferentes tipos de calculaciones. La funcion SUM es una simple demostracion
de como una funcién trabaja. =Sum(A4+C8)

% Ed Microsoft Excel - Book2

g @ File Edit ‘Wew Insert Format  Tools Data W
D8 &9 B8 o- @& =-8 |
D& - A =SUMALCE) —— > Férmula

| A B C D E

[ INE TN P
]
[}
~J
-1
m
m

Total
Celdas " EG BE
sumadas: BE 44 33
7 33 A7

11
Ad+C8 o L — =T & 2 11 717]
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b)

Como usar el AutoSum Tool —
8 st et Doz

File Edit ‘Wiew Insert Format Tools Data W

= SO S RE: B | v - | @ - &
1 Selecciones Celda B2-C5 5 - EE:Q B8V = Z\ el

. - A 7B
2 Haga click en AutoSum A B C D E
H 1
3 Presiones Enter 5 o
3 32187 £88.12
4 34.09 43,52
&
i B
. AutoSum !
Escribiendo una Formula

1 Selecciones Cell Al en un nuevo worksheet.
2. Escriba:123

3. Selecciones A2

4, Escriba: 100

5 Clic en A3y escriba: =sum(Al1+Az2) y presiones Enter

Més ejemplos: =sum(Al-A2) =sum(A3*0.0825)
Multiples calculaciones pueden ejecutarse usando el formato de formula.

Propiedades bésicas de la Férmula en Excel

0 Toda formula comienza con signo de igual (=)

0 Cuando la formula se escribe su resultado se muestra en la misma
celda.

0 Cuando una Celda que contiene una férmulas es seleccionada la

formula se muestra en la barra de formulas.

Operaciones Aritméticas:

Simbolo Funcién

=+

Suma
Sustraccion

T

T -

T * Multiplicacion

T / Division

T A Exponente

T % Por ciento (si se coloca después de un

Numero 2%)

25



Orden de las calculaciones:

Orden Operacion ___ Funcion
1 - Negativo
2 % Porcentaje
3 A Exponente
4 *and/ Multiplicacion y Division
5 +and - Suma y Sustraccion
6 & Text conectado
7 =<>,<=,>=,<> Comparacion
Ejemplos
=1+2*5

Resultado 11 (1 mas el resultado de 2 por 5), no 15(la suma de 1 mas 2
igual a 3 por 5)

La Practica en Excel

PARA ABRIL UN WORSHEET (HOJA DE CALCULO) QUE YA EXISTE

1 File = Open
2 Selecciones el Folder
3 Selecciones el Archivo y haga un doble click

PARA ALMACENAR UN WORKSHEET (HOJA DE CALCULO)

1 File =» Save
2 Selecciones el Folder
3 Escriba el nombre del documento.

PARA ALMACENAR UNA HOJA DE CALCULO (WORKSHEET BAJO OTRO NOMBRE)
1 File, =» Save As...

2 Seleccione el Folder
3 Escriba el nombre
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PARA IMPRIMIR UN WORKSHEET (HOJA DE CALCULO)

1 File,
2 Print
3 Selecciones opciones y click OK

PARA VER UN WORKSHEET (HOJA DE CALCULO) ANTES DE
IMPRIMIRLO

1 File, =» Print preview
2 Selecciones de Toolbar, si desea

Desarrolle este worksheet de acuerdo a estas CANTIDADES:

A B C D E F
J.Vargas  Norte: 200.10 Sur: 100.60 Este: 300.20 Oeste: 250.30
M. Méndez Norte: 50.20 Sur: 34.90 Este: 43:33 Oeste: 55:00
N. Lopez Norte: 420.00 Sur: 355.12 Este: 320.10 Oeste: 420.30
P. Tirado Norte: 111.11 Sur: 150.33 Este: 90.18 Oeste: 130.55
TOTAL

A
E3d Microsoft Excel - Book2

File Edit Wwiew Insert Format  Tools  Data  window  Help

DE s &Y B @ = -2 i3 2 sl -1
B2 - 123
A, E z ] E F 1
1 MNOMEBRE HNORTE SR ESTE DESTE TOTAL
2
3
4
5
(=

1 Sume la primera fila en la celda F2: =SUM(B2:E2)
2 Luego puedes copiar la formula en la celda F2 en las celdas de abajo:

2 Cuando el cursor del Mouse se convierta en una cruz arrastrelo hacia
las demas celdas y la formula autométicamente quedara copiada.
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Modificaciones a una celda o conjunto de Celdas seleccionadas

En el mend Clic en:

> Format £ Microsoft Excel - Book2

> Ce"S File Edit ‘Wew Insert Format Tools Data  wWindow  Help
DEEES &% B - @ = -4 1@ 2 A -

B4 - & MORTE
& B | ¢ | o | E | F |

1
2
3
|4 |F NOMBRE NORTE SUR ESTE DESTE | TOTAL
5 2001 100.5 300.2 250.3 851.2
B 0
7 0
g
9

FORMAT CELLS

Siguiendo el menu de esta
ventana pueden
modificarse las celdas
seleccionadas:

Ndameros:

- General

-Currency

- date, etc.

Inclusive:
-Alineamiento
-Fuentes de textos
-Los bordes de las celdas
-y otros.

Format Cells

Mumber ] Alignment ] Fonk

Presets
Mone Qutline Inside s s—
Border —_
Text Texk
Text Texk
el & Color:

Automakic -
= == =

The selected border style can be applied by clicking the presets, prewview
diagram or the buttons above,

OF, | Cancel
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INTRODUCCION: THE DATABASE (BASE DE DATOS)

Que es una base de datos (database)
Usando Microsoft Access usted se pueden manejar la informacién requerida desde una Unica
base de datos en su computadora, este sistema divide su informacion en almacenamientos
separados llamadas Tablas. Cada tabla responde a cierto criterio y necesidad, que combinada
con otras facilidades hace mucho mas facil la administracion de la informacion.

Una base de datos es una coleccion organizada de informacion. La guia de
teléfonos es un buen ejemplo de una base de datos.

Un Sistema de Administracion de Base de datos computadorizado es un programa
de computadora que asiste:

a) Almacenando la informacion

a) Recuperar la informacion

b) Ordenar la informacion (ascendente descendente)
C) Analizar la informacién

d) Imprimir la informacion

En el sistema computadorizado de base de datos la informacidn aparece en forma de tablas. Los
encabezamientos de las columnas se Ilaman Nombre de Campo. Las hileras se llaman récord.
De modo que cada hilera o linea constituye un récord en la base de datos.

Ejemplo:
First Name |Last Name [Work Phone |Fax Number
Jackie Joyner 456-2323 456-9988
John Smith 567-9834 567-4433
Mary Might 345-9977 345-1112
Carl Lewis 087-4433 087-2121

2 COMO CREAR UN DATABASE

A Selecciones
29



==> File
=_—==> Open
===> Blank database
B En la Nueva ventana puedes seleccionar
1 Open a Blank Database
2 Access Database Wizard
3 Open existing file

COMO CREAR UN TABLA DE DATOS

Para crear un nueva tabla habra la ventana de la base de datos y selecciones Table y
luego selecciones New. Access le mostrara las optiones disponibles Para:
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0 Datasheet View
0 Design View
0 Table wizard

1 Abra la ventanilla del Database

2 Click el Botdn de Nuevo (New)

3 Selecciones Design View

4 Entre el Nombre del Campo (Field Name)

5 Entre el tipo de dato (Data type: Tex, Date, Number, etc.)
6 Entre la descripcion si es necesaria

7 Entre una linea por cada campo (Field) de su tabla

4 PROPIEDADES DE CADA CAMPO (FIELD NAME)

ANNNANNANANNANNA

5 PRACTICA

Tamaro del Campo (field size)

Format (que aplica a las fechas y los nimeros)

Decimal (cuando decimales aplican a los campos numéricos)
Input Mask (que solo aplica a la fecha y texto)

Caption (encabezamiento que se vera en los reportes y output)
Default Value (es el valor del field si no se especifica otro valor)
Required (es una entrada requerida, mandatoria en el field)

Crear una base de datos usando el Wizard de MS. Access.
Crear una tabla siguiendo el material provisto.

Pdngale Captions (encabezamiento) a algunos Fields.
Agregue un campo (dias libres, weekend = Sat. Sun.)
Cambie la fecha con un Input Mask

Agregue dos decimales a los campos numéricos

Agregue un campo numeérico con un Format de Currency ($)
Almacene (Save) su tabla como “Mi Negocio”

Crear una forma (screen) automatica para entrar informacion
Entre la informacion (por los menos 10 récords.

Produzca un Query

0 Use Criterio
0 Ordénelo
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